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SENSIT® Test and Measurement Overview 
This document outlines the information related to the release of SENSIT® Test and Measurement. 

Operating Systems 
SENSIT® Test and Measurement is intended for use with one of the following Windows operating systems: 
 
▪ Windows 11 
▪ Windows 10 

Installed Files 
Default Installation Folder: 
C:\Program Files (x86)\FUTEK\SENSIT 2.13\ 
 
The following files are installed with this release: 
 
DevExpress.BonusSkins.v24.1.dll 
DevExpress.Charts.v24.1.Core.dll 
DevExpress.CodeParser.v24.1.dll 
DevExpress.Dashboard.v24.1.Core.dll 
DevExpress.Dashboard.v24.1.Win.dll 
DevExpress.Data.Desktop.v24.1.dll 
DevExpress.Data.v24.1.dll 
DevExpress.DataAccess.v24.1.dll 
DevExpress.DataAccess.v24.1.UI.dll 
DevExpress.DataVisualization.v24.1.Core.dll 
DevExpress.Diagram.v24.1.Core.dll 
DevExpress.Drawing.v24.1.dll 
DevExpress.Images.v24.1.dll 
DevExpress.Map.v24.1.Core.dll 
DevExpress.Office.v24.1.Core.dll 
DevExpress.Pdf.v24.1.Core.dll 
DevExpress.Pdf.v24.1.Drawing.dll 
DevExpress.PivotGrid.v24.1.Core.dll 
DevExpress.Printing.v24.1.Core.dll 
DevExpress.RichEdit.v24.1.Core.dll 
DevExpress. RichEdit.v24.1.Export.dll 
DevExpress. Snap.v24.1.Core.dll 
DevExpress. Snap.v24.1.dll 
DevExpress. Snap.v24.1.Extension.dll 
DevExpress.Sparkline.v24.1.Core.dll 
DevExpress.SpellChecker.v24.1.Core.dll 
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DevExpress.TreeMap.v24.1.Core.dll 
DevExpress.Utils.v24.1.dll 
DevExpress.Utils.v24.1.UI.dll 
DevExpress.Web.ASPxThemes.v24.1.dll 
DevExpress.Web.Resources.v24.1.dll 
DevExpress.Web.v24.1.dll 
DevExpress.Xpo.v24.1.dll 
DevExpress.XtraBars.v24.1.dll 
DevExpress.XtraCharts.v24.1.dll 
DevExpress.XtraCharts.v24.1.Extensions.dll 
DevExpress.XtraCharts.v24.1.UI.dll 
DevExpress.XtraCharts.v24.1.Web.dll 
DevExpress.XtraCharts.v24.1.Wizard.dll 
DevExpress.XtraDiagram.v24.1.dll 
DevExpress.XtraEditors.v24.1.dll 
DevExpress.XtraGauges.v24.1.Core.dll 
DevExpress.XtraGauges.v24.1.Presets.dll 
DevExpress.XtraGauges.v24.1.Win.dll 
DevExpress.XtraGrid.v24.1.dll 
DevExpress.XtraLayout.v24.1.dll 
DevExpress.XtraMap.v24.1.dll 
DevExpress.XtraNavBar.v24.1.dll 
DevExpress.XtraPivotGrid.v24.1.dll 
DevExpress.XtraPrinting.v24.1.dll 
DevExpress.XtraReports.v24.1.dll 
DevExpress.XtraReports.v24.1.Extensions.dll 
DevExpress.XtraRichEdit.v24.1.dll 
DevExpress.XtraScheduler.v24.1.Core.Desktop.dll 
DevExpress.XtraScheduler.v24.1.Core.dll 
DevExpress.XtraScheduler.v24.1.dll 
DevExpress.XtraScheduler.v24.1.Extensioni.dll 
DevExpress.XtraScheduler.v24.1.Reporting.dll 
DevExpress.XtraScheduler.v24.1.Reporting.Extensions.dll 
DevExpress.XtraSpellChecker.v24.1.dll 
DevExpress.XtraTreeList.v24.1.dll 
DevExpress.XtraTreeMap.v24.1.dll 
DevExpress.XtraTreeMap.v24.1.UI.dll 
DevExpress.XtraVerticalGrid.v24.1.dll 
DevExpress.XtraWizard.v24.1.dll 
FTD2XX_NET.dll 
FUTEK.Devices.dll 
FUTEK_USB_DLL.dll 
Microsoft.Bcl.AsyncInterfaces.dll 
Newtonsoft.Json.dll 
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NLog.dll 
Oracle.ManagedDataAccess.dll 
SENSIT.exe 
SENSIT.exe.config 
Resources\Audio\Continuity.wav 
Resources\Files\SENSIT EULA.rtf 
Resources\Fonts\Alphanumeric_LCD_FUTEK_IHH500.gfs 
Resources\Fonts\Alphanumeric_LCD_FUTEK_IHH500.ttf 
Resources\Icons\SENSIT_IHH_ICON.ico 
Resources\Icons\SENSIT_USB_ICON.ico 
Resources\Installation Guide\SENSIT Installation Guide.pdf 
Resources\Release Notes\SENSIT Release Notes.pdf 
Resources\Settings\Backup Utility\EEPROM\ReadMe.txt 
Resources\Settings\Backup Utility\Memory\ReadMe.txt 
Resources\Settings\Calibration\Calibration Technician.txt 
Resources\Settings\Calibration\ReadMe.txt 
Resources\Settings\Data Logging\Auto Chart.txt 
Resources\Settings\Data Logging\Create File Path Directory.txt 
Resources\Settings\Data Logging\Default File Path Directory.txt 
Resources\Settings\Data Logging\Graph Values.txt 
Resources\Settings\Data Logging\ReadMe.txt 
Resources\Settings\Data Logging\Start Type.txt 
Resources\Settings\Data Logging\Test Duration.txt 
Resources\Settings\Data Logging\Threshold Value.txt 
Resources\Settings\Data Logging\X Axis Values.txt 
Resources\Settings\Data Logging Backup\CalculatedValuesBackup.txt 
Resources\Settings\Data Logging Backup\Data Logging Backup Enabled.txt 
Resources\Settings\Data Logging Backup\ExportFileAttributes.txt 
Resources\Settings\Data Logging Backup\GraphValues.txt 
Resources\Settings\Data Logging Backup\ReadMe.txt 
Resources\Settings\Data Logging Backup\TestProperties.txt 
Resources\Settings\Data Logging Backup\XAxisValue.txt 
Resources\Settings\Device\ReadMe.txt 
Resources\Settings\Live Graph\Auto Chart.txt 
Resources\Settings\Live Graph\Create File Path Directory.txt 
Resources\Settings\Live Graph\Default File Path Directory.txt 
Resources\Settings\Live Graph\Graph Values.txt 
Resources\Settings\Live Graph\ReadMe.txt 
Resources\Settings\Live Graph\Refresh Rate.txt 
Resources\Settings\Live Graph\Samples to Display.txt 
Resources\Settings\Live Graph\Start Type.txt 
Resources\Settings\Live Graph\Test Duration.txt 
Resources\Settings\Live Graph\Test Interval.txt 
Resources\Settings\Live Graph\Threshold Value.txt 
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Resources\Settings\Live Graph\X Axis Values.txt 
Resources\Settings\Math Channel\Enable Channel.txt 
Resources\Settings\Math Channel\Math Channel Units.txt 
Resources\Settings\Math Channel\Math Decimal Format.txt 
Resources\Settings\Math Channel\Math Values.txt 
Resources\Settings\Math Channel\ReadMe.txt 
Resources\Settings\Scale Method\ReadMe.txt 
Resources\Settings\Sensor\ReadMe.txt 
Resources\Settings\Sum Channel\Enable Channel.txt 
Resources\Settings\Sum Channel\ReadMe.txt 
Resources\Settings\Sum Channel\Sum Channels.txt 
Resources\Settings\Sum Channel\Sum Decimal Format.txt 
Resources\Settings\Sum Channel\Sum Values.txt 
Resources\Settings\System\Display Refresh Rate.txt 
Resources\Settings\System\Display Table Column Names.txt 
Resources\Settings\System\Front Panel Orientation.txt 
Resources\Settings\System\Front Panel Zoom.txt 
Resources\Settings\System\ReadMe.txt 
Resources\Settings\TEDS\ACDCCouplingEnum.txt 
Resources\Settings\TEDS\AnalogOutputSetupEnum.txt 
Resources\Settings\TEDS\BridgeTypeEnum.txt 
Resources\Settings\TEDS\CalSetEnum.txt 
Resources\Settings\TEDS\Chr5Enum.txt 
Resources\Settings\TEDS\CJSourceEnum.txt 
Resources\Settings\TEDS\DirectionEnum.txt 
Resources\Settings\TEDS\ElecSigTypeEnum.txt 
Resources\Settings\TEDS\ElectricalValuePrecisionEnum30.txt 
Resources\Settings\TEDS\ElectricalValuePrecisionEnum33.txt 
Resources\Settings\TEDS\ExcitationPowerRequirementsEnum.txt 
Resources\Settings\TEDS\ExciteTypeEnum.txt 
Resources\Settings\TEDS\GageTypeEnum.txt 
Resources\Settings\TEDS\ManufacturerIDEnum.txt 
Resources\Settings\TEDS\MapMethEnum.txt 
Resources\Settings\TEDS\MicSizeEnum.txt 
Resources\Settings\TEDS\MicTypeEnum.txt 
Resources\Settings\TEDS\PhysicalMeasurandUnitsEnum.txt 
Resources\Settings\TEDS\PolarizationEnum.txt 
Resources\Settings\TEDS\ReadMe.txt 
Resources\Settings\TEDS\Resp_TypeEnum.txt 
Resources\Settings\TEDS\SignEnum.txt 
Resources\Settings\TEDS\TCTypeEnum.txt 
Resources\Settings\TEDS\VersionLetterEnum.txt 
Resources\Settings\TEDS\YesNoEnum.txt 
Resources\User Guide\SENSIT User Guide.pdf 
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Supported Devices 
The following devices are supported with this release: 
 
ETH100 
IAA105 
IDA100 
IDC100 
IDC200 
IHH500 
IPM650 
QIA123 
QIA124 
QIA128 
USB100 
USB110 
USB120 
USB200 
USB210 
USB215 
USB220 
USB225 
USB230 
USB240 
USB320 
USB410 
USB520 
USB530 
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Release History 

Current Release (Version 2.13) 

SENSIT® Test and Measurement Version 2.13.0.0 

Release Version 

Version Number: 2.13.0.0 
Version Released: November 21, 2024 
Revision Type:  Minor Revision 

New Features 

▪ Added device support for QIA124. 
▪ Added message in live graphing informing the user that the export file is still open when they attempt to write to it 

after a new test. 

Changes 

▪ Auto Teds feature is now per device instead of a system wide setting. 

Fixes 

▪ Fixed issue where IPM650 peak values were the same as tracking values. 
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Previous Release (Version 2.12) 

SENSIT® Test and Measurement Version 2.12.1.0 

Release Version 

Version Number: 2.12.1.0 
Version Released: August 16, 2024 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed issue related to database login. 
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SENSIT® Test and Measurement Version 2.12.0.0 

Release Version 

Version Number: 2.12.0.0 
Version Released: July 27, 2024 
Revision Type:  Minor Revision 

New Features 

▪ Added License Deactivation 
▪ Added License Activation (Offline) 
▪ Added License Deactivation (Offline) 
▪ Added improved error logging capabilities. 

Changes 

▪ Updated documents that can be viewed from the Help menu. 

Fixes 

▪ Bug 7862: Fixed Display Table when TEDS unit of measure (UOM) is set to "oz-in" 
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Previous Release (Version 2.11) 

SENSIT® Test and Measurement Version 2.11.8.0 

Release Version 

Version Number: 2.11.8.0 
Version Released: June 12, 2024 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ Updated TEDS automation used at FUTEK factory. 

Fixes 

▪ Fixed issue with TEDS where the data was read twice after saving. 
▪ Fixed issue with USB225 and Record Shunt feature during calibration. 
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SENSIT® Test and Measurement Version 2.11.7.0 

Release Version 

Version Number: 2.11.7.0 
Version Released: April 18, 2024 
Revision Type:  Build Revision 

New Features 

▪ Added device support for USB225 Pro Elite to calibrate RTD. 

Changes 

▪ Updated SENSIT startup for quicker launch. 

Fixes 

▪ Fixed issue with TEDS capacity and unit of measure in Display Table > Device Settings > Profile context menu. 
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SENSIT® Test and Measurement Version 2.11.6.0 

Release Version 

Version Number: 2.11.6.0 
Version Released: March 14, 2024 
Revision Type:  Build Revision 

New Features 

▪ Added support for USB225 firmware version 4.3.0. 
▪ Added feature to cancel file export. 

Changes 

▪ Updated USB225 calibration to be performed when TEDS is enabled. 

Fixes 

▪ Fixed unit conversion bug. 
▪ Fixed status label display. 
▪ Fixed data logging from freezing during export. 
▪ Fixed checkbox label dimensions. 
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SENSIT® Test and Measurement Version 2.11.5.0 

Release Version 

Version Number: 2.11.5.0 
Version Released: January 16, 2024 
Revision Type:  Build Revision 

New Features 

▪ Implemented new licensing to support the features in SENSIT® Test and Measurement and SENSIT® Calibration. 

Changes 

▪ None. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.11.4.0 

Release Version 

Version Number: 2.11.4.0 
Version Released: November 17, 2023 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ Updated calculations for wire cutting automation at FUTEK factory. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.11.3.0 

Release Version 

Version Number: 2.11.3.0 
Version Released: September 19, 2023 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed issue where some controls were beyond the form boundaries. 
▪ Fixed issue affecting timing of certain features at FUTEK factory. 
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SENSIT® Test and Measurement Version 2.11.2.0 

Release Version 

Version Number: 2.11.2.0 
Version Released: September 11, 2023 
Revision Type:  Build Revision 

New Features 

▪ Added support for wire cutting automation at FUTEK factory. 

Changes 

▪ None. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.11.1.0 

Release Version 

Version Number: 2.11.1.0 
Version Released: September 06, 2023 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed issue during calibration where channel name selection is no longer required to be set. 
▪ Fixed issue during calibration where channel number selection is no longer required to be set. 
▪ Fixed issue during calibration where IAA105 bandwidth is selected during dual calibration mode. 
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SENSIT® Test and Measurement Version 2.11.0.0 

Release Version 

Version Number: 2.11.0.0 
Version Released: August 29, 2023 
Revision Type:  Minor Revision 

New Features 

▪ Added device support for IAA105 to display temperature and sensor health. 
▪ Added device support for IAA105 calibrations performed at FUTEK. 
▪ Added device support for QIA128 calibrations performed at FUTEK to capture the ADC values on demand. 

Changes 

▪ Replaced trademark symbol SENSIT™ with registered trademark symbol SENSIT® 

Fixes 

▪ Fixed issue with USB225 when using TEDS, the unit of measure is displayed incorrectly in profile context menu on 
startup. 
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Previous Release (Version 2.10) 

SENSIT® Test and Measurement Version 2.10.2.0 

Release Version 

Version Number: 2.10.2.0 
Version Released: July 14, 2023 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed Calibration Direction Type Counterclockwise misspelling issue. 
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SENSIT® Test and Measurement Version 2.10.1.0 

Release Version 

Version Number: 2.10.1.0 
Version Released: June 30, 2023 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed issue with Display Table context menu when selecting a device and Sum Channel is enabled. 
▪ Fixed issue with Display Table context menu when selecting a device and Math Channel is enabled. 
▪ Fixed issue with Display Table context menu when selecting the Sum Channel. 
▪ Fixed issue with Display Table context menu when selecting the Math Channel. 
▪ Fixed issue with Calibration Mode and the corresponding tabs that are visible depending on devices connected. 
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SENSIT® Test and Measurement Version 2.10.0.0 

Release Version 

Version Number: 2.10.0.0 
Version Released: May 31, 2023 
Revision Type:  Minor Revision 

New Features 

▪ Added QIA check for multiple directions to determine if ready. 
▪ Added USB check for multiple directions to determine if ready. 
▪ Added calibration settings for QIA123, QIA128, and USB225. 

▪ Allow the calibration user to select the channel name, channel number, and direction type. 
▪ Allow the calibration user to recall previous calibration settings. 
▪ Allow the calibration user to update the calibration date when recalibration is performed. 
▪ Added analog calibration settings for QIA123. 

Changes 

▪ Updated all references to USB225 Pro and USB225 Pro Elite. 
▪ Updated unit conversion when tare is set. 
▪ Updated RTD channel now shows NAN when RTD is not present. 

Fixes 

▪ Fixed QIA Counterclockwise misspelling issue. 
▪ Fixed QIA negative direction issue. 
▪ Fixed QIA123 shunt label to correctly display On or Off after a power cycle. 
▪ Fixed QIA123 shunt return code after a power cycle. 
▪ Fixed USB negative direction issue. 
▪ Fixed USB225 where Tare value is transferred to profile 1 when profile was changed. 
▪ Fixed USB225 where TEDS unit of measure label was applied to profile 1. 
▪ Fixed issue with checked appearance in drop down menus. 
▪ Fixed scale method units when profile changes. 
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Previous Release (Version 2.9) 

SENSIT® Test and Measurement Version 2.9.0.0 

Release Version 

Version Number: 2.9.0.0 
Version Released: February 02, 2023 
Revision Type:  Minor Revision 

New Features 

▪ Added device support for QIA123 calibrations performed at FUTEK. 
▪ Added device support for QIA128 calibrations performed at FUTEK. 
▪ Added support for new TEDS chip DS28EC20 with USB225 Pro. 

Changes 

▪ None. 

Fixes 

▪ None. 
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Previous Releases (Version 2.8) 

SENSIT® Test and Measurement Version 2.8.1.0 

Release Version 

Version Number: 2.8.1.0 
Version Released: November 16, 2022 
Revision Type:  Build Revision 

New Features 

▪ Added option to Live graph temperature (°C) for the USB225 Pro. 
▪ Added labels to indicate TEDS in display table for the USB225 Pro. 
▪ Added labels to clarify which serial number corresponds to the profile in the context menu for the USB225 and USB225 

Pro. 

Changes 

▪ Updated timing for DS2433 4Kb 1-Wire EEPROM when used with the USB225 Pro. 
▪ Updated serial number display logic for the USB225 and USB225 Pro. 

▪ If Profile 0 is selected and TEDS is enabled/connected, then the TEDS serial number is displayed. 
▪ If Profile 0 is selected and TEDS is not connected, then the instrument serial number is displayed. 
▪ If Profile 1 is selected, then the sensor serial number is displayed. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.8.0.0 

Release Version 

Version Number: 2.8.0.0 
Version Released: October 12, 2022 
Revision Type:  Minor Revision 

New Features 

▪ Added device support for USB225 and USB225 Pro calibrations performed at FUTEK. 

Changes 

▪ Improved performance when using the USB225 Pro and TEDS. 
▪ Improved timing after read and write commands. 
▪ Applied changes to loading points and unit of measure when changing profiles. 
▪ Applied changes to loading points and unit of measure when updating TEDS contents. 

Fixes 

▪ None. 
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Previous Releases (Version 2.7) 

SENSIT® Test and Measurement Version 2.7.10.0 

Release Version 

Version Number: 2.7.10.0 
Version Released: August 25, 2022 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed USB225 issue where the negative sign (-) was not being displayed for the output readings. 
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SENSIT® Test and Measurement Version 2.7.9.0 

Release Version 

Version Number: 2.7.9.0 
Version Released: June 23, 2022 
Revision Type:  Build Revision 

New Features 

▪ Added device support for the QIA123. 
▪ Added profile selection for the USB225. 
▪ Added shunt selection for the USB225. 
▪ Added TEDS support for the USB225 Pro. 

Changes 

▪ Removed Auto Detect New Devices feature so that it can be reviewed and updated to improve speed and accuracy. 

Fixes 

▪ None. 



 
 SENSIT® Release Notes 10 Thomas, Irvine, CA 92618, USA 

Email: futek@futek.com 

 

 Page 26 of 62 

SENSIT® Test and Measurement Version 2.7.8.0 

Release Version 

Version Number: 2.7.8.0 
Version Released: March 09, 2022 
Revision Type:  Minor Revision 

New Features 

▪ Added device support for the USB225. 

Changes 

▪ Changed .xlsx as the default file extension for file export when Microsoft Excel is installed on the computer. 
▪ Changed .txt as the default file extension for file export when Microsoft Excel is not installed on the computer. 
▪ Removed .xls file extension from the file export options for data logging and live graphing. 
▪ Updated support for Microsoft Excel based on Microsoft Lifecycle Policy. 

▪ Currently support Microsoft Excel 2013 and newer. 
▪ Removed support for Microsoft Excel 2010 and older. 

Fixes 

▪ Fixed IDA100 calibration issue where the full-scale load and unit code were being overwritten with default values. 
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Previous Releases (Version 2.6) 

SENSIT® Test and Measurement Version 2.6.6.0 

Release Version 

Version Number: 2.6.6.0 
Version Released: April 20, 2021 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ Updated database connection strings. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.6.5.0 

Release Version 

Version Number: 2.6.5.0 
Version Released: March 23, 2021 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ Updated Calibration Technician list in Calibration Settings. 
▪ Updated Copyright information. 
▪ Updated TEDS Transducer Type Template. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.6.4.0 

Release Version 

Version Number: 2.6.4.0 
Version Released: August 17, 2020 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ Updated TEDS User Data Templates. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.6.3.0 

Release Version 

Version Number: 2.6.3.0 
Version Released: June 17, 2020 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ Updated Calibration Technician list in Calibration Settings. 
▪ Updated Copyright information. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.6.2.0 

Release Version 

Version Number: 2.6.2.0 
Version Released: October 25, 2018 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ Updated Calibration Technician list in Calibration Settings. 
▪ Updated Copyright information. 
▪ Updated End-User License Agreement (EULA). 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.6.1.0 

Release Version 

Version Number: 2.6.1.0 
Version Released: October 11, 2017 
Revision Type:  Minor Revision 

New Features 

▪ Ability to enable and disable devices through SENSIT®. 
▪ Ability to turn on and off automatic detection of added or removed devices. 
▪ Ability to set option to open an export file after creation. 
▪ Ability to set threshold alarms on device outputs. 
▪ Backup in Live Graphing. 

Changes 

▪ Warning to user when a calibration is about to take place stating that the operation can affect device output. 
▪ Splash screen in data logging showing that a test is in progress. 
▪ Indication in the display table that shunt and/or scale method is enabled. 
▪ Profile serial number is included in test exports. 
▪ Warning in scale method if a device’s units are not in mV/V. 
▪ Steps to enable scale method has been updated to a more intuitive interface. 
▪ Status column in display table has been removed. 
▪ millinewton (mN) unit has been added. 
▪ Ability to set alias for a math or sum channel. 

Fixes 

▪ Sampling rate is included to CSV exports. 
▪ IDA units are no longer being updated when SENSIT® is opened or closed. 
▪ SENSIT® no longer will detect non-FUTEK devices. 
▪ Calculator will now show entire formula. 
▪ Fixed bug related to reloading of calibration technician name. 
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Previous Releases (Version 2.5) 

SENSIT® Test and Measurement Version 2.5.1.0 

Release Version 

Version Number: 2.5.1.0 
Version Released: May 08, 2017 
Revision Type:  Minor Revision 

New Features 

▪ Ability to calibrate the IDA through shunt. 

Changes 

▪ Ability to add and remove devices in SENSIT® without restarting session. 
▪ Virtual Mode can be enabled in SENSIT® in the Display Table when no devices are enabled. 
▪ All grid user interface controls have been replaced with DevExpress grid controls. 
▪ Test data is exported if a device errors out during a test. 
▪ Removal of device selection form that was presented when starting SENSIT®. 

Fixes 

▪ Fixed bug where data logging backup was not working with particular cultural settings. 
▪ Fixed bug where SENSIT® would crash if a device errored out during a Live Graph or Data Logging test. 
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Previous Releases (Version 2.4) 

SENSIT® Test and Measurement Version 2.4.0.0 

Release Version 

Version Number: 2.4.0.0 
Version Released: February 03, 2017 
Revision Type:  Minor Revision 

New Features 

▪ Added elapsed time option to record time from the start of the test rather than the time of day. 
▪ Added new chart designer for data logging and live graphing. 

Changes 

▪ PBI 1269 – Removed number of samples and ADC value columns from tables and when exported to a file. 
▪ PBI 1271 – Updated chart settings to allow peak, valley and/or tracking values to be displayed and exported. 
▪ Updated chart controls for data logging and live graphing. 
▪ Updated model selection flow layout control to only display connected models and added IDA image. 

Fixes 

▪ Bug 2483 – Fixed issue with cultural information when exporting comma/decimal to Excel. 
▪ Bug 2783 – Fixed issue with unit conversion when using the TEDS profile in IHH500/IPM650. 
▪ Bug 2784 – Fixed issue with incorrect context menu being displayed in display mode for IHH500. 
▪ Bug 2785 – Fixed issue with decimal point precision going to infinity when using the TEDS profile in IHH500/IPM650. 
▪ Bug 3083 – Fixed issue with data logging where an exception is thrown when using the IHH500. 
▪ Bug 3412 – Fixed issue with live graph where the sum channel fails when devices included in sum channel are not 

enabled for the live graph chart. 
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Previous Releases (Version 2.3) 

SENSIT® Test and Measurement Version 2.3.4009.0 

Release Version 

Version Number: 2.3.4009.0 
Version Released: Aug 31, 2016 
Revision Type:  Build Revision / Bug Fix 

New Features 

▪ Data Logging 
▪ Added a new setting to create a backup file containing the data collected during the test. 
▪ Added a function to stop a test that is in progress. 
▪ Added a function to restore the test from the backup file. 

Changes 

▪ Display Table 
▪ Update readings and units of measure when changed on the IHH and IPM front panel keypad. 

▪ Sum Channel 
▪ Replaced Enable Channel Button with ToggleSwitch. 
▪ Replaced Tracking, Peak and Valley Value Buttons with RadioButtons. 
▪ Replaced Sum Channel Buttons with CheckBoxes and only display available channels. 

▪ Math Channel 
▪ Replaced Enable Channel Button with ToggleSwitch. 
▪ Replaced Tracking, Peak and Valley Value Buttons with RadioButtons. 
▪ Updated saved settings to include the formula from the calculator. 

▪ Calculator 
▪ Replaced Close Button with Apply Button. 
▪ Removed Postfix Notation TextBox. 
▪ Combined Infix Notation, Result and Display TextBoxes into a Panel. 
▪ Infix Notation is now referred to as Formula. 

▪ Data Logging Settings 
▪ Removed Apply Button. 
▪ Moved several GroupBoxes into a FlowLayoutPanel to only display relevant settings to the models selected. 

▪ Data Logging Graph 
▪ Changed default series width (line thickness) to 2 pixels. 

▪ Live Graph Settings 
▪ Removed Apply Button. 

▪ Live Graph  
▪ Changed default series width (line thickness) to 2 pixels. 

▪ Calibration Settings 
▪ Removed Apply Button. 

▪ Culture Information 
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▪ Removed Apply Button. 

Fixes 

▪ Fixed a threading issue where the Live Graph test would not stop when the Stop Test Button is pressed, and the Math 
Channel is enabled. 

▪ Fixed a threading issue where the Live Graph test would throw a System.IndexOutOfRangeException stating “There is 
no row at position …” 

▪ Fixed an issue where the Live Graph would move off the graph completely when the X-Axis Value is set to Time. 
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SENSIT® Test and Measurement Version 2.3.4008.16 

Release Version 

Version Number: 2.3.4008.16 
Version Released: June 17, 2016 
Revision Type:  Bug Fix 

New Features 

▪ Added calibration support for the IDC200. 

Changes 

▪ Updated calibration settings control layout. 
▪ Moved the settings directory, subfolders, and files to the resources directory. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.3.4008.15 

Release Version 

Version Number: 2.3.4008.15 
Version Released: June 09, 2016 
Revision Type:  Bug Fix 

New Features 

▪ Added device support for the IDC200. 

Changes 

▪ None. 

Fixes 

▪ Removed unused local variables. 
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SENSIT® Test and Measurement Version 2.3.4008.14 

Release Version 

Version Number: 2.3.4008.14 
Version Released: January 22, 2016 
Revision Type:  Bug Fix 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed an exception where the Serial Number ComboBox failed to list all the available serial numbers. The exception may 
occur when non-FUTEK USB devices are connected that use the same FTDI drivers. 
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SENSIT® Test and Measurement Version 2.3.4008.11 

Release Version 

Version Number: 2.3.4008.11 
Version Released: November 12, 2015 
Revision Type:  Bug Fix 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed an unhandled exception in live graphing during the export of data to Microsoft Excel. The exception only occurs 
when using a combination of an IHH/IPM and USBXXX. 
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SENSIT® Test and Measurement Version 2.3.4008.10 

Release Version 

Version Number: 2.3.4008.10 
Version Released: August 25, 2015 
Revision Type:  Bug Fix 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed production features used by the factory. 
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SENSIT® Test and Measurement Version 2.3.4008.9 

Release Version 

Version Number: 2.3.4008.9 
Version Released: July 31, 2015 
Revision Type:  Bug Fix 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed production features used by the factory. 
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SENSIT® Test and Measurement Version 2.3.4008.8 

Release Version 

Version Number: 2.3.4008.8 
Version Released: April 16, 2015 
Revision Type:  Build Revision / Bug Fix 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed the timing related to the calibration procedure of the IHH500 and IPM650. 
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SENSIT® Test and Measurement Version 2.3.4007.7 

Release Version 

Version Number: 2.3.4007.7 
Version Released: August 12, 2014 
Revision Type:  Build Revision / Bug Fix 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed the default load switch settings related to the USB520 and USB530. 
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SENSIT® Test and Measurement Version 2.3.4006.6 

Release Version 

Version Number: 2.3.4006.6 
Version Released: July 22, 2014 
Revision Type:  Build Revision / Bug Fix 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed the timing related to the calibration procedure of the IDA100. 
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SENSIT® Test and Measurement Version 2.3.4005.5 

Release Version 

Version Number: 2.3.4005.5 
Version Released: April 30, 2014 
Revision Type:  Build Revision / Bug Fix 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed an error that resulted when using TEDS and Data Logging. 
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SENSIT® Test and Measurement Version 2.3.4004.4 

Release Version 

Version Number: 2.3.4004.4 
Version Released: February 26, 2014 
Revision Type:  Build Revision / Bug Fix 

New Features 

▪ None. 

Changes 

▪ Updated the labels for IHH500 and USB520 for use at the factory. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.3.4003.3 

Release Version 

Version Number: 2.3.4003.3 
Version Released: January 23, 2014 
Revision Type:  Build Revision / Bug Fix 

New Features 

▪ Added support for the ETH100, IDA100 and USB240. 
▪ Added support for IHH500 and USB520 for use at the factory. 

Changes 

▪ Updated the Resources directory for better file management. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.3.4002.2 

Release Version 

Version Number: 2.3.4002.2 
Version Released: August 23, 2013 
Revision Type:  Build Revision / Bug Fix 

New Features 

▪ Added configuration support for the IHH500 and IPM650. 
▪ Added support for quadrature encoders. 
▪ Added Transducer Electronic Data Sheets (TEDS) automation to support factory calibrations. 
▪ Added database tables to support the TEDS automation at the factory. 

Changes 

▪ Updated the calculations to support quadrature encoders based on hardware and firmware versions. 
▪ Updated file and directory names to reduce the number of characters in the file path. 

▪ Please note: This may affect the saved settings created in a previous version of SENSIT®. The settings may have 
to be saved again using the newer version of SENSIT®. 

▪ Updated the setup.exe prerequisites to support the latest hardware drivers.  

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.3.4001.1 

Release Version 

Version Number: 2.3.4001.1 
Version Released: June 07, 2013 
Revision Type:  Build Revision / Bug Fix 

New Features 

▪ Added device support for the USB530. 
▪ Added a warning message to alert the user when the software is unable to find the FTDI Drivers. The message indicates 

the options that the user must resolve the issue or to continue to use the software in the Virtual Mode. 

Changes 

▪ Updated the setup and deployment package to make use of InstallShield. 

Fixes 

▪ Fixed the Virtual Mode to support the use of SENSIT® without a FUTEK USB Device being present. 
▪ Fixed the Angle Reset to support USB410, USB520 and USB530. 
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SENSIT® Test and Measurement Version 2.3.4000.0 

Release Version 

Version Number: 2.3.4000.0 
Version Released: February 21, 2013 
Revision Type:  Minor Revision 

New Features 

▪ Added device support for the USB520. 
▪ Added the ability to enable / disable the tracking, peak and valley values from the Data Logging Graph and the Live 

Graph. 
▪ Added a warning message to alert the user that the software will be launched in Virtual Mode. 
▪ Added an Export option to the Data Logging and Live Graph tabs that allows the user to export even after the test 

results have already been exported. 
▪ Added the ability to show or hide selected columns and rows from the Display Table. 
▪ Added the ability to copy data from the Data Logging and Live Graphing Tables. 
▪ Added a descriptive alias field for each unique device serial number that can be saved. 

Changes 

▪ Changed the default file names used when exporting data to include date and time. 
▪ Changed the Display Table Refresh Rate to include additional intervals from 0.1 Hz to 25 Hz. 
▪ Changed the Live Graph Test Interval to allow inputs by the user as small as 0.005 seconds (200 SPS). 
▪ Restructured the subroutines used to export data to .csv and .txt files to decrease the export time. 
▪ Restructured the subroutines used to export data to .xls and .xlsx files to allow for larger amounts of data acquisition. 

Fixes 

▪ None. 
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Previous Releases (Version 2.2) 

SENSIT® Test and Measurement Version 2.2.4006.5 

Release Version 

Version Number: 2.2.4006.5 
Version Released: August 06, 2012 
Revision Type:  Build Revision / Bug Fix 

New Features 

▪ Added the ability to support TEDS sensors programmed for legacy instruments. 
▪ Added the ability to correct for symmetry differences in TEDS sensors using dual scaling. 

Changes 

▪ Updated the scope of Microsoft Excel from a global variable to a local variable. 
▪ Updated the files used to store TEDS settings to text documents (*.txt). 
▪ Updated the FTDI D2XX Drivers from version 2.08.14 to 2.08.24. 

Fixes 

▪ Fixed the application data directory to include the files that relate to TEDS settings. 
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SENSIT® Test and Measurement Version 2.2.4005.4 

Release Version 

Version Number: 2.2.4005.4 
Version Released: June 25, 2012 
Revision Type:  Bug Fix 

New Features 

▪ Added the ability to save the display table column names. 
▪ Added the ability to save the conversion units. 

Changes 

▪ Updated the sum channel to display the conversion units instead of the base calibration units. 
▪ Updated the sum channel to not display units when the selected channels have different conversion units. 

Fixes 

▪ Fixed the algorithm used to determine if the trial period is expired or has been modified. 
▪ Fixed the calculation used with TEDS to handle arithmetic overflow exceptions. 
▪ Fixed the formatting of data when saving settings to accommodate different regional settings. 
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SENSIT® Test and Measurement Version 2.2.4004.3 

Release Version 

Version Number: 2.2.4004.3 
Version Released: May 21, 2012 
Revision Type:  Bug Fix 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed the algorithm used to determine if the trial period is expired or has been modified. 
▪ Fixed the file path used to open the Software Manual from the Help Menu. 
▪ Fixed the Data Logging Counter used when logging data with the Normal_Data_Request command. 
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SENSIT® Test and Measurement Version 2.2.4003.2 

Release Version 

Version Number: 2.2.4003.2 
Version Released: May 03, 2012 
Revision Type:  Bug Fix 

New Features 

▪ None. 

Changes 

▪ Reorganized the collection order of the Calibration Mode Tab. 

Fixes 

▪ Fixed the algorithm used to determine if the trial period is expired or has been modified. 
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SENSIT® Test and Measurement Version 2.2.4002.1 

Release Version 

Version Number: 2.2.4002.1 
Version Released: May 01, 2012 
Revision Type:  Bug Fix 

New Features 

▪ None. 

Changes 

▪ None. 

Fixes 

▪ Fixed the software to allow the user to continue using the software with limited functionality once the Trial Period has 
expired. 
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SENSIT® Test and Measurement Version 2.2.4001.0 

Release Version 

Version Number: 2.2.4001.0 
Version Released: April 28, 2012 
Revision Type:  Build Revision 

New Features  

▪ None. 

Changes 

▪ Updated the connection string related to the database used to store calibration information generated by FUTEK 
personnel only. 

Fixes 

▪ None. 
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SENSIT® Test and Measurement Version 2.2.4000.0 

Release Version 

Version Number: 2.2.4000.0 
Version Released: April 19, 2012 
Revision Type:  Minor Revision 

New Features 

▪ Added the features that were exclusively available in the SENSIT® Instrument software to this release. 
▪ Display Front Panel 
▪ Data Logging Registers 
▪ Live Graph Registers 
▪ Transducer Electronic Data Sheets (TEDS) 

▪ Added device support for the IHH500, IPM650, USB215 and USB410. 
▪ Added the use of a product key to validate the license that has been purchased. 
▪ Added the use of a trial period for those who would like to evaluate the software. 
▪ Added the model selection form when multiple model categories are detected. 
▪ Added the ability to select which device(s) to use when data logging or live graphing. 
▪ Allowed the live calibration feature in the Calibration Mode to be used with a valid license or before the trial period 

expires. 

Changes 

▪ Updated the software name to SENSIT® Test and Measurement. 
▪ Removed Global Mode from the File Menu and added Global Settings to the Display Settings Menu. 
▪ Removed some of the items from the Format Menu to allow the settings from the operating system to be used instead. 
▪ Reorganized the setup or settings for data logging, live graphing, and calibration. 
▪ Updated the units displayed in the Scale Method section to reflect the calibrated units of the device. 
▪ Updated the installation process to automatically prompt the user to install the prerequisite software. 

Fixes 

▪ The Refresh Rate in Live Graph Settings now accepts the input of a single-precision floating-point number instead of a 
32-bit signed integer. 

▪ The Status in the Device Settings is now saved. 
▪ The default location used when saving a data logging or live graph file has been updated to support the different 

directories in the supported operating systems. 
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Previous Releases (Version 2.1) 

SENSIT® Test and Measurement Version 2.1.4000.0 

Release Version 

Version Number: 2.1.4000.0 
Version Released: November 17, 2011 
Revision Type:  Minor Revision 

New Features 

▪ Added device support for the USB120 and USB320. 
▪ Added Unit Codes table to the Additional Information section. 
▪ Added the Shunt feature to the Calibration Mode. 
▪ Added the Culture Information to the Format Menu which allows the user to select the regional settings to use when 

formatting numbers, dates, and time. 
▪ Added the support of different directories based on the supported operating systems. 

Changes 

▪ Updated the software name to SENSIT® Test and Measurement. 
▪ Reorganized the settings for data logging, live graphing, and calibration. 
▪ Restructured the read and write subroutines related to the packetized data transfer to optimize the response time. 
▪ Added an additional layer of error checking to the read and write subroutines allowing for the retransmission of data 

within the allotted time. 

Fixes 

▪ None. 
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Previous Releases (Version 2.0) 

SENSIT® USB Software Version 2.0.4000.0 

Release Version 

Version Number: 2.0.4000.0 
Version Released: July 27, 2011 
Revision Type:  Build Revision 

New Features 

▪ None. 

Changes 

▪ Updated the software name to SENSIT® USB Software. 
▪ Updated the build revision to reflect the Microsoft .NET Framework use and the build number. 

▪ Build revision 4000 represents Microsoft .NET Framework 4.0 and build number 00.  

Fixes 

▪ None. 
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FUTEK USB Software Version 2.0.0.0 

Release Version 

Version Number: 2.0.0.0 
Version Released: January 25, 2011 
Revision Type:  Major Revision 

New Features 

▪ Complete redesign of the Graphical User Interface (GUI). 
▪ Added support for up to 16 different devices at once. 
▪ Added support for exporting data to .xls or .xlsx files. 
▪ Added the ability to modify individual device settings or apply settings globally. 
▪ Added the ability to save settings for future use of the software. 
▪ Added the ability to modify the look and feel of the software through the Format Menu. 
▪ Added the Additional Information to the Help Menu which allows the user to review the current settings of the 

software and firmware that relate to a specific device. 

Changes 

▪ Upgraded to Microsoft .NET Framework 4.0. 
▪ Updated the data logging feature to capture data based on the hardware’s sampling rate. 
▪ Updated the graphing capabilities to make use of newer and more powerful controls. 
▪ Updated the main display to a tabular format to accommodate future releases and flexibility. 

Fixes 

▪ This release was a major revision and was not released to fix any previous releases. 
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Release Information 
SENSIT® 2.13 Release Notes – Released November 2024 

Copyright 
© 2024 FUTEK Advanced Sensor Technology, Inc. All rights reserved. 

Disclaimer 
Neither the whole nor any part of the information contained in, or the product described in this manual, may be adapted, 
or reproduced in any material or electronic form without the prior written consent of the copyright holder. 
 
This product and its documentation are supplied on an as-is basis and no warranty as to their suitability for any particular 
purpose is either made or implied. 
 
This document provides preliminary information that may be subject to change without notice. 

Contact Information 
FUTEK Advanced Sensor Technology, Inc. 
 
Headquarters 
10 Thomas 
Irvine, CA 92618 
 
Business hours: 
7 am – 5 pm Pacific 
 
Phone: (949) 465-0900 
Email: futek@futek.com 
Website: www.futek.com 
 

mailto:futek@futek.com
http://www.futek.com/

